
 EarthLink MailBox
The EarthLink MailBox provides the basic tools for sending and receiving email.    
The MailBox window consists of the following: Folders, Message List, the Message Preview Header and the Message Preview
 Right click on any message to pop up a menu of options .
Using the MailBox Toolbar 
Using Folders 
Creating Mail Folders 
Using the Message List

For more information about EarthLink 5.0, see   EarthLink Help   



 Using the Message List
The Message List shows a summary of the messages in the current folder. (The current folder has a gray background). For each
message, you see the name or email address of the sender, the subject of the message and the date and time the message was
received (Inbox, Junk Mail) or created (Drafts, Outbox, and Sent).    Unread messages are bold and show a closed envelope 
icon.    If the message contains any attachments, you see a paperclip the left of the envelope icon.
Click on a message to preview the body of the message in the Message Preview
Double-click on a message to open it in a new window.



 Collecting Email 
By default, EarthLink MailBox checks for new mail every 20 minutes and sends any messages waiting in your Outbox.    You can 
change how often MailBox checks for new mail or you can turn off this feature by modifying your MailBox preferences .

You can check for mail any time; just click  Check on the EarthLink MailBox toolbar, or select Check Mail on the MailBox 
menu.



 Using the MailBox Toolbar

The EarthLink MailBox toolbar provides easy access to the following mailbox functions:
Read Write Reply Reply All Forward Check Delete Junk (or Unjunk ) Address Print Filter Find 
To change the appearance of your MailBox toolbar:

 Right click on the toolbar to pop-up a menu.
 Select one of the following:

¨ Check Text Labels to place a text description beneath each button.
¨ Check Small Toolbar to make the toolbar buttons smaller. The toolbar will take up less space on your screen.
¨ Check Large Toolbar to make the toolbar buttons larger for easier viewing.
¨ Uncheck View Toolbar to turn off the toolbar.    
¨ All of the toolbar functions are also available on the Message menu, or by right clicking on a message; so you can 

uncheck the toolbar to turn it off and have more space on your screen to view messages.



 Sorting Email
You can sort the mail messages listed in the Message List for any folder by the column heading.    You can also sort the 
messages into folders, by dragging them from the Message List into a folder or by creating filters that put incoming mail into 
specific folders.

To sort messages in your Inbox by sender, click the From column heading.    
To sort messages in your Inbox by subject, click the Subject column heading.
To sort messages in your Inbox by the date and time received, click the Received column heading.

An arrow in the heading indicates the sort direction, up or down. To sort the messages in any of the other folders, just click on the
column heading. Click the column heading again to change the sort direction.



 Reading Email
Your Email arrives in your Inbox and is listed, usually by date and time (although you can sort the list by any column). This list 
shows the header for each message.    It tells you who sent the message, when it was received, and what it’s about.

To read a message in the message preview pane of the MailBox, highlight the message in the message list.
To display a message in a new window, double click on the message header.

You can also reread messages in other folders.    Just open the desired window and highlight the desired message in the 
message list.



 Opening an Email Message
Your Inbox lists the Email messages that you have collected from your mailbox on any mail server you have defined. EarthLink 
MailBox periodically checks the defined mail server for new Email.    (If you don’t see any new messages in your Inbox, you can 

collect them by clicking  Check.)
To open a mail message in a new window:

 Click on the Email message you want to open, then click 

 Read.    The message opens in a new window.
Once you’ve read your email you can:

Open or save the attachment 
Print it 
Reply to the Sender 
Reply to Sender and All Recipients 
Forward it 
Save it 
Delete it 
Create a new message 
Add the Sender to your Blocked Senders List 
Add the Sender to your Address Book 
Open the Address Book 



 Finding Text in a Message
To find text in a message:
 Click Find on the MailBox toolbar then enter the text you want to locate and press OK.



 Finding a Message
If you’re waiting for a message about a specific subject, you can search the subject line and the body of the messages in the 
current folder to quickly locate the message containing the desired text. 
To find text in a message subject:
 Click 

 Find on the MailBox toolbar.

 Enter the text you want to locate and press OK.



 Forwarding an Email Message
Sometimes you get a message you want to pass along to someone else.
 Click on the email message you want to forward, then click Forward.
A new Mail Message window opens, allowing you to enter the new recipient’s address, as well as add your own text to the 
message.

You can also forward several emails at once:
 Click on the first email message that you want to forward.
 Press the CTRL button on your keyboard, and hold it while you click the other message(s) that you want to forward. They will all 

remain highlighted.
 Click Forward.

As when forwarding one email message, a new Mail Message window will open, and all the forwarded emails will be sent as 
attachments .

Entering an Email Address 
Selecting an Email Address from your Address Book 



 Replying to an Email Message
Many times when you receive an email message, you want to reply to it immediately.    The Reply feature opens a new mail 
window and addresses it to the person you just received mail from (the person you want to reply to).    You can also reply to the 
sender and all recipients.
To reply to an email message:
 Click on the Email message you want to reply to, then click 

 Reply.    A new mail window opens with the To address already filled in.    
 Type the text of your message then click 

 Send.



 Replying to All
To reply to the sender and all recipients of an email message:
 Click on the Email message you want to reply to, then click 

 Reply.    A new mail window opens with the To and CC addresses already filled in.    
 Type the text of your message then click 

 Send.



 Saving an Attachment
If an email message has an attachment, there will be a picture of a paperclip to the left of the envelope icon in the message list, 
and an Attachments button on the message preview bar.
To save an attachment:
 In the message list, select the email that has an attachment you wish to save.
 Click Attachments in the message preview bar to display the name of the attachment and its size. If there is more than one 

attachment, then they will all be displayed.
At this point you can either:

 Click the name of the attachment you wish to save. The Open Attachment window will appear, and you can select the folder you
want to save the attachment to, then click Save.
Or:

 Click Save Attachments. This will open the Save Attachments window, and allow you to save all the attachments to the same 
place at the same time. In the Save To field, choose the folder you want to save the attachments to, then click Save.



 Printing an Email Message
To print a copy of any email message:
 Click on the message you want to display then click 

 Print.



 Marking previewed messages as ‘Read’
To mark previewed messages as ‘read’:

 Right click on the message to display the pop-up menu.

 Select Mark as Read.
The icon will change from a closed envelope to an open envelope.



 Marking previewed messages as ‘Unread’
To mark previewed messages as ‘unread’:

 Right click on the message to display the pop-up menu.

 Select Mark as Unread.
The icon will change from an open envelope to a closed envelope.



 Copying a message to another folder
To copy a message to another folder:

 Right click on the message to display the pop-up menu.

 Select Copy To.

 Select the folder you want to copy the selected message to, then click OK.



 Moving a message to another folder
To move a message to another folder:

 Right click on the message to display the pop-up menu.

 Select Move To.

 Select the folder you want to copy the selected message to, then click OK.



 Deleting an Email Message
To delete an email message:

 Click on the Email message you want to delete, then click 

 Delete. The message(s) get sent to the Trash folder.
Tip: If you want to automatically empty your Trash folder when you close the EarthLink MailBox, check the “Empty messages 
from the Trash folder when MailBox is closed” option in the EarthLink MailBox configuration. 



 Getting Mail from your EarthLink Mailbox
Before messages shows up on your computer, it gets collected in your mailbox on the EarthLink mail server (and any other 
server you’ve setup).    You need to retrieve Email from the mail server before you see it in the Inbox on your computer. By 
default, EarthLink MailBox checks for new mail every 20 minutes and sends any messages waiting in your Outbox.    You can 
change the frequency or you can turn off this feature by modifying your MailBox preferences .

 Click 

 Check to check the mail server for new mail and retrieve it to your Inbox.    This also sends any mail in your Outbox to the 
mail server for distribution to the intended recipients.    
If you only want to retrieve new messages, select Receive New Messages on the MailBox menu.
If you only want to send outgoing messages, select Send Outgoing Messages on the MailBox menu.



 Saving a Message
To save a mail message

 Double-click on the message in the message list to open the message in a new window.

 Select Save As... from the File menu.

 Enter a name for the file. Be sure to add an extension, such as .txt, to the filename.



 Sending Outgoing Messages
To send messages in your Outbox WITHOUT collecting mail from the mail server:

 Select Send Outgoing Messages from the MailBox menu.



 Receiving New Messages
You can check for new email from the MailBox inbox by clicking Check on the MailBox toolbar.

When you receive a new email message, a new email icon  will appear 
on your task bar in the lower right corner of your screen. Click that icon to bring up your inbox.



 Viewing the Message Source
Messages can arrive as plain text or HTML.    If you want to see how an HTML message was coded, select View Message 
Source on the Mailbox menu.    
The Message Source window will also show complete message headers.    (Complete message headers show more detail about 
the sender and the various servers that processed the message.)



 Organizing Email
You can create additional email folders that you can use to sort your email messages, just like you sort memos and other 
documents into manila folders.    You can drag a message from one folder into another.    Or you can create filters that sort mail 
before it ever reaches your Inbox.    For example, if your friend Jane always sends you jokes, you can create a Jokes folder and 
a Jokes filter.    The filter sends all messages from Jane to the Jokes folder.      If you receive mail from a mailing list or from a 
college organization, you can create a folder to collect all those messages and a filter to send them there.
Creating a New Folder 
Using Filters 



 Controlling Junk Mail
Junk mail is any unsolicited mail that you would rather not receive. The Junk button enables you to “junk” or send these 
messages to the Junk Mail folder and to add the sender’s email address to the Blocked Senders list.    When new email comes
in from an address listed in the Blocked Senders list, the message is routed to the Junk Mail folder automatically.    You can edit
the Blocked Senders List.
To junk a mail message:

 Click on the message containing the email address you want to include in your junk mail list, then click 

 Junk.
The sender’s email address gets added to your Blocked Senders list, the message gets moved to the Junk Mail folder and 
future mail from this sender will automatically be sent to Junk Mail. You can undo this entire process by using the Unjunk 
feature.

You can also use EarthLink’s automated Mail Scrubbers Mail Scrubbers to destroy unwanted email before you have to see it.

Editing your Blocked Senders List 
Filtering Email 
Unjunking an email 



  Creating a New Email Message
To create a new mail message:

 Click 

 Write to open a message window.

 Click in the From box to open a pull-down menu, then choose which email address you want to send the message from (you
may only have one choice).

 Click in the To box, and type the recipient’s email address or address book name (or enter it automatically from the address 
book. How to do this).

 Enter the text of your message in the bottom half of the window.
Before you send your email message, you may want to:

· Formatting Your Email Message 
· Get an Address from your Address Book  
· Add an attachment to it 
· Save it as a draft 
· Print it 
· Delete it 
· Spell check it 
· Open the Address Book 
· Send it now 



 Addressing an Email Message
Email messages use a format similar to memorandums.    Each message consists of a header and a message body.    The 
header tells you who the message is from, the date and time the message was sent, other recipients, and the subject of the 
message.    The main difference is that an email message header uses email addresses for the sender and recipient instead of 
just names.
When addressing an email message, you can use the standard memo categories for the intended recipients – To:, Cc:, and Bcc:.
You can type the email addresses or select them from your address book.



 Selecting Email Recipients from your Address Book
To select email recipients from your address book:

 In the Write Mail window, click 

 Addresses.
The names of the people listed in your address book appear to the left of the message header (To, Cc, Bcc etc.).

 Highlight the name(s) of the people you want to send mail to, then click To, Cc, or Bcc.    The name will appear in the 
appropriate field of the message header.

Adding Addresses to your Address Book 



 Adding an Attachment
An attachment is any existing document you would like to include with your email message. It can be a document, chart, graphic 
or any other type of file stored on your computer. Any file on your computer can be attached to an email message.
To attach a file to your email message:

 Click 

 Attach on the Write Mail toolbar to open the Open file dialog.

 Select the file you want to attach, then click Open.
You will see the name of the file listed beneath the body of the message.



 Copying Text from One Email Message to Another
If you find a quote from an email message you’ve received, or if you’ve written something that you would like to use again, you 
can copy it from one email to another.
To copy text from one mail message to another:

 Highlight the text you want to copy, then select Copy from the Edit menu.

 Open the new message (or document) you want to place the text in, then select Paste from the Edit menu.



 Saving a Draft of a Message
EarthLink MailBox automatically saves a draft of each new message.    But you can manually save a draft of a message any 
time.

 Click the close button (the X in the upper right corner of the window) to close the window.

 In response to the prompt, click Yes.    The message gets saved to the Drafts folder.
You can open any message in the Drafts folder to review, edit, send or delete. 



 Spell Checking an Email Message
To spell check a message:

 Click 

 Spell Check.    Spell check displays your errors, with possible corrections, one at a time.

 
¨ Suggestions lists other alternatives – highlight a word in this list to move it to the Change to field.
¨ Capitalization shows a word that is not capitalized but should be, such as england. 
¨ Consider changing shows a word you may have changed in the past so it is marked in the dictionary as "Conditionally 

Change”. 
¨ Double word shows two identical words in a row, such as that that. 
¨ Mixed case shows a word with an unusual combination of upper- and lower-case letters.
¨ Contains digits shows a word that contains numbers, such as Windows95. 
¨ Not in dictionary shows a word in your mail message that is not in the dictionary, such as sdfqz.    If you want to add this

word to the dictionary, click Add to Dictionary. 
¨ Change to shows the recommended word. You can type a correction in this field.
¨ Click Change if you want to replace the problem word with the word in the Change to field. 
¨ Click Change All to replace all occurrences of the misspelled word. 
¨ Click Ignore to ignore this word or click Ignore All to ignore all occurrences of this word. 
¨ Undo reverses the change you just made. Undo is disabled when you use the Change All feature.
¨ Suggest populates the suggestion list – use this when you type in a word in order to check its spelling.



 Sending an Email Message 
When you’re connected, your new message gets sent as soon as you click Send.
If you’re not connected, clicking Send places your message in the Outbox so it can be sent the next time you connect.
You can send and receive Email anytime by clicking Check. If you want to send (but not receive) Email, select Send Outgoing 
Messages from the Mailbox menu.



 Using Folders
Electronic folders, like their paper counterparts, are useful for sorting and organizing information.    MailBox contains six basic 
folders for sorting and storing email (Inbox, Outbox, Trash, Sent, Draft, Junk Mail) but you can create as many more as you 
would like. You can even add folders inside of other folders.    For example, if you want to keep a folder in the Inbox to store all of 
the messages from your family, you could add a folder called Family to the Inbox folder.
¨ The Inbox contains all of the incoming email you have collected from EarthLink – read and unread.
¨ The Outbox contains all of the mail messages that are ready to be sent the next time you go online.
¨ The Sent folder contains all of the mail messages that you have sent.
¨ The Drafts folder contains drafts of mail messages you have started and saved for later modification before sending 

(selecting Save from the File menu).    You can open and review the messages in this folder before taking action on them.
¨ The Trash folder contains mail messages you have deleted (from any other folder).    You should periodically clean out your 

folders by deleting mail messages (sending them to the trash).    Additionally, you should periodically empty the trash.
¨ The Junk Mail folder contains mail message that you have junked.
If a folder name is bold, it contains an unread message.



 Inbox
The Inbox contains your incoming mail messages, read and unread.    Unread messages appear in bold and the envelope icon is
closed.    Read messages show an open envelope icon.    You can collect new messages any time by clicking the Check button 
on the MailBox toolbar.
Open a Folder 
Create a new folder within the Inbox 

Once you open the Inbox folder, right click on a message to pop-up a menu and do any of the following:
Mark as Read 
Mark as Unread 
Copy To... 
Move To... 

Read It 
Junk It 
Print it 
Reply to the Sender 
Reply to Sender and All Recipients 
Forward it 
Save it 
Delete it 
Open or save the attachment 
Mark it as   ‘  Read  ’   
Mark it as ‘Unread’
Copy it to another Folder
Move it to another Folder
You can also do the following:
Create a new message 
Add the Sender to your Blocked Senders List 
Add the Sender to your Address Book 
Open the Address Book 



 Outbox
The Outbox contains messages waiting to be sent. 
Open a Folder 
Create a new folder within the Outbox 

Once you open the Outbox folder, you can do the following:
Read 
Forward 
Mark as Read 
Mark as Unread 
Copy To... 
Move To... 
Delete 



 Drafts Folder
The Drafts folder contains drafts of any messages you have not yet sent.    If you close the Write Mail window while writing a new
mail message, you will be prompted to save your message to the Drafts folder.    If you choose Yes the message will be filed here
for later use. EarthLink MailBox also periodically saves mail you are writing to the Drafts folder. 
Open the Drafts Folder 
Create a new folder within the Draft Folder 

Once you open the Drafts folder, you can do the following by right clicking on a message to pop-up a menu:
Read 
Forward 
Mark as Read 
Mark as Unread 
Copy To... 
Move To... 
Delete 



 Sent Folder
The Sent folder stores all of the messages you have sent. 
Open the Sent Folder 
Create a new folder within the Sent Folder 

Once you open the Sent folder, you can do the following by right clicking on a message to pop-up a menu:
Read 
Reply 
Reply to All 
Forward 
Junk 
Mark as Read 
Mark as Unread 
Copy To... 
Move To... 
Delete 



 Trash Folder
The Trash Folder stores all of the messages you have deleted.    
Empty Trash 
Open the Trash Folder 
Create a new folder within the Trash Folder 

Once you open the Trash folder, you can do the following by right clicking on a message to pop-up a menu:
Read 
Reply 
Reply to All 
Forward 
Junk 
Mark as Read 
Mark as Unread 
Copy To... 
Move To... 
Delete 



 Junk Mail Folder
Email gets sent to the Junk Mail folder for one of three reasons.
1. The email originated from someone in your Blocked Senders list.
2. You have selected the message, and then clicked the Junk button on the MailBox toolbar.
3. The email was sent there by the Mail Scrubber.

 To empty the Junk Mail folder, right-click it, and choose Empty Folder. This will send all the messages to the Trash folder.

Right-click on a message within the Junk Mail folder to do one of the following:
Read 
Forward 
Unjunk
Mark as Read 
Mark as Unread 
Copy To... 
Move To... 
Delete 



 Creating Email Folders
As you accumulate email, you can organize it into folders.    This keeps your Inbox uncluttered so you can easily scan through 
mail for a particular message.    You can add a folder to your EarthLink MailBox, or you can create a new folder inside an existing
folder.
To add a folder to your EarthLink MailBox:

 Right click on the folder list, or on the EarthLink MailBox icon in the folder list, to pop up a menu.

 Select New Folder... 

 Enter a name for the folder
Organizing Folders 
Opening a Folder 
Renaming a Folder 
Deleting a Folder 
Moving a Folder 



 Opening a Folder
To open a folder:

 Click on the folder name or right click on the folder name and select Open.
The messages in the folder appear in the message list.



 Adding a New Folder
To add a new folder to the EarthLink MailBox:

 Right click on the EarthLink MailBox icon in the folders list, or on any blank space in the folder list and select New Folder.    

 Enter a name for the new folder on the Create New Folder dialog and click OK.
To add a new folder to an existing folder:

 Right click on the folder name then select New Folder.
You can drag messages from the message list into another folder or you can right click on the message summary and select 
Move To from the menu.



 Organizing Folders
You can reorganize folders and their contents.
Adding a New Folder 
Renaming a Folder 
Moving a Folder 
Deleting a Folder 



 Renaming a Folder
To rename a folder:

 Right click on the folder name.

 Select Rename.

 Enter the new name for the folder then click OK.
You cannot rename the six original folders (Inbox, Outbox, Trash, Sent, Drafts, or Junk Mail).    



 Deleting a Folder
To delete a folder:

 Right click on the folder name.

 Select Delete.

 Click Yes to confirm that you want to delete the folder and all of its contents.
You cannot delete one of the six original folders (Inbox, Outbox, Trash, Sent, Drafts, or Junk Mail).    These must remain the main
folders in EarthLink MailBox.



 Moving a Folder
To move a folder that you created:

 Drag it from one folder to another.
OR

 Right click on the folder name.

 Select Move.

 Select the folder you want to move the folder into and click OK.
For example, if you created a folder in your Inbox called Jokes and you would prefer Jokes to be a main folder in the EarthLink 
MailBox, drag Joke from the Inbox to the EarthLink Mailbox.
You cannot drag the six original folders (Inbox, Outbox, Trash, Sent, Drafts, or Junk Mail) to another folder.    



 Compacting Folders
Compacting your Mail folders frees up space on your system.
To compact your Mail folders:

 Close any open Mailbox and Write Mail windows.

 Select Compact Folders on the Mailbox menu.



 Emptying the Trash
Your Trash folder collects all of the mail messages you have deleted.    If you don’t have your preferences set to clean out your 
Trash folder automatically, every once in a while you need to clean out your Trash folder.    

 Click Empty Trash to remove all messages in the Trash folder permanently.
Setting your Email Preferences 



 Using the Address Book
To use the Address Book:

 Click 

 Address Book on the MailBox toolbar to open the Address Book Editor.
This window lists the names and addresses in your address book.
Adding an Address 
Editing an Address 
Deleting an Address 
Using Names from the Address Book in a Mail Message 



 Adding an Address to your Address Book
To add an address to your address book:

 Click Address Book on the MailBox toolbar to open the Address Book Editor dialog.
The Address Book Editor dialog lists the entries in your address book.

 Click Add to open the Add Address Book Entry dialog.

 Enter the name that you want displayed when you show the open address book in Write Mail. 

 Enter the email address.

 Click OK.
Selecting Email Recipients from your Address Book 



 Adding Names to your Address Book
The email addresses for people to whom you send mail and who send mail to you are automatically added to the Address Book.  
You can also manually add addresses to the Address Book.
To add names to your address book:

 Click the Address Book button on the MailBox toolbar to open the Address Book Editor dialog.
This dialog lists the names and email addresses already in your Address Book.

 Click Add to open the Add Address Book Entry dialog.

 Enter the name for your friend or associate as you would like it to appear in the address book.

 Enter the email address for the person, then click OK.



 Editing an Address Book Entry
To edit an address book entry.

 Open the Address Book by clicking 

.

 Double-click on the address you want to modify to display its properties, or highlight the entry and click Edit.

 Make the desired changes then click Ok. 



 Saving an Address
By default addresses of the people to whom you send mail are automatically saved to your Address Book.



 Deleting an Address Book Entry
To delete an address book entry:

 Open the Address Book by clicking 

.

 Highlight the address you want to remove from your address book, then click Delete. A confirmation window will appear.

 Click Yes to confirm the deletion.



 Configuring EarthLink MailBox
To configure how the EarthLink MailBox looks and behaves:

 Click Configure on the EarthLink Sign On dialog then click Manage Profiles to open the Manage Profiles window.

 Click 

 Mail under Settings to open the Mail General tab.



 Adding the Sender to your Blocked Senders List
When you receive unsolicited mail, you can throw it away and add the sender to your Blocked Senders List.    The Blocked 
Senders List is a list of senders you don’t care to receive mail from.    Any incoming messages from a sender on the Blocked 
Senders List will automatically be placed in your Junk Mail folder.
To “junk” a message and add its sender to the Blocked Senders List:

Click  Junk.
The sender’s email address is added to the Blocked Senders List and the message is moved to the Junk Mail folders.

You can manually add senders to your Blocked Senders List .



 Editing the Blocked Senders List
To manually add a sender to your Blocked Senders list:
 Select Edit Blocked Senders from the MailBox menu.

From this dialog you can delete a sender, edit a sender entry or add a sender to the list.
 Click Add to open the Add New Blocked Sender dialog.

 Enter the display name for the sender and the email address then click OK.



 Filtering Email
An email filter works just like a coffee filter.    A coffee filter keeps the grounds out of your coffee, and the email filter keeps the 
mail you don’t want out of your Inbox.    You just need to select one of EarthLink’s predefined filters or build your own.
For example, if your friend Jane always sends jokes and only jokes, you can create a folder for Jokes and create a filter that 
sends all of Jane’s messages directly to the Jokes folder.    You Inbox won’t be cluttered with jokes and you can still read them at
your leisure.    
EarthLink offers two predefined filters: the Mail Scrubber and the Aggressive Mail Scrubber, both of which are designed to 
eliminate "spam" from your inbox..    
To select one of the predefined filters:
 Click 

 Filter on the MailBox toolbar to open the Filter Editor.

 Check the desired filter then click OK.
OR you can do any of the following:
Build your Own Filter(s) 
Control Junk Mail 
Add Address Book Entries 



 Adding a Filter
To add a filter:
 Click the Filter button on the MailBox toolbar to open the Filter Editor dialog.
 Click Add. 

The Filter Rule Wizard   –   Step 1: Select the Conditions   dialog appears.    The From, To, Cc, and Subject fields refer to the
fields of the incoming message.

 Check the condition(s) that you want to check each incoming message for, then click Next>.
The Filter Rule Wizard   –   Step 2: Select the Action   dialog appears.

 Check the action(s) you would like to perform on any message that meets your condition(s), then click Next>.
The Filter Rule Wizard   –   Step 3: Verify and Name the Rule   dialog appears.

 Verify the conditions and actions you specified, and enter a name for this new filter.
 Click Finish to save your filter.    The filter name appears on the list of filters on the Filter Editor dialog.    
 Click OK to close the Filter Editor dialog.



 Aggressive Mail Scrubber
The Aggressive Mail Scrubber only lets you see mail from users that are listed in your Address Book.    Any mail sent to you that 
is not from email addresses in your Address Book is destroyed – you’ll never even know the mail was sent to you.    This is a 
great filter for kids since you only want them to get mail from people they know.
Note: For these filters to be effective, you must have the following mail preference settings checked, Automatically put people 
I send mail to into my Address Book. 



 Mail Scrubber
The Mail Scrubber is a basic mail filter designed to dump most unsolicited mail into the Junk Mail folder. If your email address 
does NOT appear in the To: or Cc: fields AND the message is NOT From an email address listed in your Address Book, the 
message is automatically moved to the Junk Mail folder.    When you use this filter mail from people listed in your Address Book 
will ALWAYS be delivered to the Inbox, regardless of how they addressed the message (unless you’ve created another filter that 
moves mail messages from certain senders to another folder). How well you maintain your Address Book determines how well 
this filter works.    If you select this filter and find “good” mail in Junk Mail folder, you need to add some entries to your Address 
Book or consider creating your own mail filters.



 Building your Own Filter(s)
To build your own mail filter:
 Click Filter on the MailBox toolbar to open the Filter Editor.    The filters are listed in the order they will be processed when you 

receive new mail. 
 Click Add to launch the Filter Rule Wizard.    

The first step is to select the conditions you want applied to your incoming mail. 
 Select the desired condition(s) then click Next>.        For example, if you want to create a filter that sends all of Jane’s jokes to a 

Jokes folder (the folder must already exist), check If the From field contains the following text: and enter Jane’s email address 
janeypooh@earthlink.net into the field, then click Next>. 
The second step is to decide what you want done with mail that matches the conditions you selected in Step 1.

 Select your action.    For example, to move Jane’s message to the Jokes folder, check Move the message to the folder: then 
click the button to the right of the field and select the Jokes folder from the list and click Next>.
The third step is to verify the conditions and actions in the filter you created and to give the filter a name.

 Review your filter and enter a name, then click Finish. For example, Jane’s Jokes is the name of the filter.
Your filter appears on the list of filters – and is checked to show that it is now active.    Only checked filters are processed in the order
they appear on this list.    

Editing a Filter 
Reorganizing Filters 
Inactivating a Filter 
Deleting a Filter 
Turning a Filter On or Off 



 Editing a Filter
You cannot edit either the Mail Scrubber or the Aggressive Mail Scrubber but you can edit any filters you created.
To edit a filter:
Click the Filter button on the MailBox toolbar to open the Filter Editor dialog. This dialog lists the filters that have been defined 
on this computer.    A check mark indicates an active filter.
 Select the filter you want to delete from the list of filters on the Filter Editor dialog, then click Edit. 

The Filter Rule Wizard   –   Step 1: Select the Conditions   dialog appears.
 Check or uncheck the conditions that you want to use as part of this filter then click Next>.

The Filter Rule Wizard   –   Step 2: Select the Action   dialog appears.
 Change the actions as desired then click Next>.

The Filter Rule Wizard   –   Step 3: Verify and Name the Rule   dialog appears.
 Verify the conditions and actions you specified.
 Click Finish to save your filter.



 Deleting a Filter
To delete a filter:
Click the Filter button on the MailBox toolbar to open the Filter Editor dialog. This dialog lists the filters that have been defined 
on this computer.    A check mark indicates an active filter.
 Select the filter you want to delete from the list of filters in the Filter Editor dialog, then click Delete. A confirmation window will 

appear.
 Click Yes to confirm the deletion.
You cannot delete the Mail Scrubber or the Aggressive Mail Scrubber. If you want to turn off the Mail Scrubber filters, simply 
uncheck them.



 Turning Filters On and Off
To turn filters on or off:
 Click the Filter button on the MailBox toolbar to open the Filter Editor dialog. This dialog lists the filters that have been defined on 

this computer.    A check mark indicates an active filter.
 Uncheck the filter you no longer want to use.
Mail Scrubber 
Aggressive Mail Scrubber 
Adding a New Filter 
Editing a Filter 
Deleting a Filter 
Reorganizing Filters 



 Reorganizing Filters
To reorganize filters:
 On the Filter Editor dialog, select the filter you want to move then click either Move Up or Move Down. 



 Deactivating a Filter
To deactivate a filter:
 On the Filter Editor dialog, uncheck a checked filter.



 Setting your Email Preferences
You can control how your email program behaves.
To set your email preferences:
 Click Configure on the EarthLink Browser toolbar to display the Manage Profiles window.
 Click the Mail icon under Settings to display the Mail General tab.

 Check the desired options:
¨ Setting Message Notification
¨ Checking for the Default Mail Client
¨ Checking for New Mail
¨ Emptying Trashed Messages Automatically



 Message Pop-Up Menu
The following options appear when you right click on a message. Grayed out options are not available for the selected message.
Read 
Write 
Reply 
Reply to All 
Forward 
Junk 
Mark as Read 
Mark as Unread 
Copy To... 
Move To... 
Delete 



 Using the Write Mail Toolbar

Send 
Check Spelling 
Show Addresses 
Add Attachment 
Print 



 Sample Filters
You can create filters to:
Put jokes to a jokes folder 
Send a reply to selected senders 
Put business messages in a different folder 
Forward messages from a specific sender 



 Directing business messages to a different folder
If you regularly receive mail from business associates, you directi mail from those senders to a Word folder.
 Add a new folder; name it “Work”.
 Add a new filter.

· On the Filter Editor dialog, click Add.
· On the Filter Rule Wizard – Step 1 window, check if the From field contains the following text: and enter the email 

address of the person whose email you want forwarded.
· On the Filter Rule Wizard – Step 2 window, select Move the message to the folder and click ... to select the folder 

named Work from the folder in your mailbox.



 Putting Jokes into a Joke Folder
If you have friends that send you mostly jokes, you can send all messages from them to a Jokes Folder.
 Add a new folder; name it “Jokes”.
 Add a new filter.

· On the Filter Editor dialog, click Add.
· On the Filter Rule Wizard – Step 1 window, check if the From field contains the following text: and enter the email 

address of the person that sends you mostly jokes.
· On the Filter Rule Wizard – Step 2 window, select 

Move the message to the folder: and click ... to select the folder Jokes from the folders in your mailbox.



 Forward messages from a specific sender
You can forward messages to others using a filter.    For example, if you are expecting email from an important source but you’re 
going to be out of town, you can forward the message to someone else in your office.
{bmc DO-IT.bmp) Create the text of the message you want to forward.    Use any text editor.
 Add a new filter.
· On the Filter Editor dialog, click Add.
· On the Filter Rule Wizard – Step 1 window, check if the From field contains the following text: and enter the email 

address of the person whose email you want forwarded.
· On the Filter Rule Wizard – Step 2 window, select Forward the message to the address(es): and enter the address you 

want the message forwarded to, or click ... to select an address from your address book.



 Sending a reply to selected Senders
You can automatically send a reply to certain senders. For example, if you want business associates to know you’re on vacation,
you would create reply text in a document that gives them the date you’ll be back in the office and emergency contact 
information.
 Create and save a document that contains your vacation notice, Vacation.doc.
 Add a new filter.

· On the Filter Editor dialog, click Add.
· On the Filter Rule Wizard – Step 1 window, check if the From field contains an address which is: and check in my 

address book.
· On the Filter Rule Wizard – Step 2 window, select Reply to the message with the file and enter the name of the 

document you created, vacation.doc, or use the ... button to select the document from.



 Downloading a skipped message
If have EarthLink MailBox configured to leave message larger than 500K on the server, any large messages get skipped when 
you retrieveyour email messages.    (You’ll see a note in the status bar that tells you if a message has been skipped.    Skipped 
messages will stay on the mail server until you retrieve them.
To download a skipped message:
 Click Results (beneath the message preview) to open the Results dialog.

The Results dialog describes the file(s) that were skipped.
 Click Receive Large Messages Now to begin downloading any skipped messages.



 Collecting your mail while you’re travelling
If you’re not taking your computer with you on the road, you can collect your EarthLink mail while in an Internet cafe.
Set up a mail account with one of the free email services if you don’t already have one.
Write down your EarthLink account information.    This is on the Mail Settings- Account Info tab for your profile.    You will need 
your account name, email address, Outgoing mail (SMTP) server and Incoming mail (POP3) information.
Modify the setting for External mail.    You will need to supply the information you wrote down about your EarthLink account.
You may want to leave your mail on the EarthLink mail server until you get home. 



 Leaving messages on the Server after downloading
If you’re collecting your mail while on the road, and you’re not using your computer, you may want to be able to access those 
messages when you return home.    Therefore you should leave the messages on the EarthLink Mail Server while you’re 
travelling. 
To leave messages on the server after downloading:
 Click Configure.
 Select Mail under Settings and click the Read tab.
 Check Leave messages on server after downloading.



 Removing read mail periodically
To remove read mail automatically:
 Click Configure.
 Select Mail under Settings and click the Read tab.
 Check Remove read mail from my Inbox after X day(s), then enter a number.



 Automatically adding senders to your Address Book
To automatically add people to your address book:
 Click Configure.
 Select Mail under Settings and click the Read tab.
 Check Automatically put people I receive mail from into my Address Book.



 Restricting large downloads
If you have limited space on your computer or if you’re in a hurry an don’t want to wait for large attachments to download from 
the mail server, you can restrict the size of attachments.    
To restrict large downloads:
 Click Configure.
 Select Mail under Settings and click the Read tab.
 Check Don’t download messages if the attached files are larger than X Kb, then enter a number.



 Automatically marking previewed messages as read
To automatically mark previewed messages as read:
 Click Configure.
 Select Mail under Settings and click the Read tab.
 Check Mark message as read after being preview for X seconds, then enter a number.



 Running spell check automatically
To run spell check every time you send mail
 Click Configure.
 Select Mail under Settings and click the Send tab.
 Check Check spelling before sending mail.



 Adding name and signature to all outgoing mail
To add your name and/or signature to all outgoing mail:
 Click Configure.
 Select Mail under Settings and click the Send tab.
 Enter your name and or signature as you would like it to appear on all outgoing messages.



 Automatically adding recipients to the Address Book
To add people you send mail to your address book:
 Click Configure.
 Select Mail under Settings and click the Add Server tab.
 Check Automatically put people I send mail to into my Address Book.



 Adding the International mail server
To add the International mail server:
 Click Configure.
 Select Mail under Settings and click the Add Server tab.
 Click New Server to display the New Server dialog.
 Enter your account name and password
 In the Incoming mail (POP3) field, enter ismtp.earthlink.net.
 Click Ok.



MailBox window



 Attachment Filters
Certain types of files are more likely than others to contain viruses (a certain kind of program which can be harmful to your 
computer). Files ending with .vbs are notorious for carrying viruses. EarthLink warns you when you are about to save or open an
email attachment that contains a .vbs file, but you can turn off this warning, or add other kinds of files to the warning list.
 Click Configure in the EarthLink main window to open the Manage Profiles window. If you’re not signed on, click Configure 

from the EarthLink 5 Sign On window, then click Manage Profiles.
 Choose Mail from the Settings for list.
 Click the Read tab.
 Click the Attachment Filters button to open the Attachment Filters List.

To add other file types to the list:
 Click within the large white box to put your cursor there. Put a space after the previous file type, and type the file extension that 

you want to add, making sure to precede it with * and a period (for example, *.vbs *.bat).
 Click OK to return to the Profile Manager.

To turn the warning off or on:
 Click in the small box underneath the list, next to the words Don’t warn.
 Click OK to return to the Profile Manager.



 Importing Email Messages
You can import messages from other email programs into your EarthLink MailBox.
 From the File menu, choose Import, then choose Messages to open the import wizard.
 Choose the email program that you would like to import messages from, and click Next to go to the next window in the wizard 

(Select location to import from).

Click the Help button on that page for more help, or click:
Help on Selecting a Location



 Select location to import from
EarthLink will import your email messages from the default message location unless you choose a different location.
If you’re not sure where your email messages are stored click Next to accept the default.
If you would rather choose a different location to import messages from, click the Browse button to browse to the appropriate 
folder. Click OK to accept the location you have chosen, then click the Next button to go to the next page in the wizard (Select 
folders to import).

Click the Help button on that page for more help, or click:
Help on Selecting folders to import 



 Select folders to import
EarthLink needs to know which email folders you would like to import to your MailBox.
 To import all the folders, click the All folders radio button, then click Next to begin importing your messages.
 To import certain folders but not all of them, select a folder you want to import by clicking on it, then press and hold the CTRL 

button on your keyboard while you click any other folders you want to import. Then click the Next button to begin importing your 
messages.

Once the messages have finished importing, click Finish.



Unjunk
You can easily remove an email message from the Junk Mail folder, by using the Unjunk button on the MailBox toolbar. When 
you unjunk a message, it gets moved to the Inbox, and its sender is taken off of your Blocked Senders list .

New messages from that sender will not be blocked, but any messages that are already in your Junk Folder will stay there until 
you move them.

To Unjunk an email message:
 From the Junk Mail folder, select the message that you would like to unjunk, and click the Unjunk button on the MailBox toolbar 

(it changes to the Junk button when you are in any other folder).



Blocked Senders List
The Blocked Senders list contains the list of senders you no longer wish to receive mail from.

You can add or remove senders from this list by selecting "Edit Blocked Senders" from the MailBox menu.



Email Attachments
An attachment is any existing document you would like to include with your email message. It can be a document, chart, graphic 
or any other type of file stored on your computer. Any file on your computer can be attached to an email message.



Edit Address Book opens the Address Book Editor so you can add, edit or delete address book entries.



Edit Blocked Senders opens the Blocked Senders Editor.    Mail from senders on this list will be sent to the Junk Mail 
folder automatically.



Open opens the highlighted email message.



Show Addresses is a toggle.    When ON (down) the address book is open to the left of the message header in the Write 
Mail window.



Read opens the message in a separate window.



Write New opens a new Write Mail window so you can compose a new mail message.



Add Attachment enables you to select a file that you want to add to the current message as an attachment.



Mark as Read changes the icon in the message list for the selected message from a closed envelope to an open 
envelope and makes the message summary normal text (not bold).



Mark as Unread changes the icon in the message list for the selected message from an open envelope to a closed 
envelope and makes the message summary bold.



Copy To... opens the Copy Message dialog so you can select the folder you want to copy the selected message to.



Move To... opens the Move Message dialog so you can select the folder you want to move the selected message to.



Open opens the selected folder, listing its contents in the message list.



Rename opens the Rename folder dialog so you can enter a new name for the selected folder.    



Delete prompts you to confirm that you want to move the selected folder and all of its messages into the Trash folder.



New Folder opens the Create New Folder dialog so you can enter a name for your new folder.



Empty Trash permanently deletes the contents of the Trash folder. 



Print Attachment prints the current attachment.



Save Attachment As opens the Save Attachment As dialog so you can select the folder in which to save this 
attachment.



Add    Attachment opens the Open file dialog so you can add an attachment to the current message.



Remove Attachment removes this attachment from the current message.



Reply opens a new message window with the To address filled in so you can send a message back to the sender.



Reply to All sends a reply to the sender and all recipients of the message.



Edit Filters opens the Filter Editor dialog.



Delete deletes the current message.



Forward views the next message.



Junk “junks” the current message – moves the message to the Junk Mail folder and adds the senders address to your 
list of Blocked Senders.



Send and Receive sends any mail in your Outbox and collects any mail waiting for you at EarthLink.



Find opens a dialog on which you can enter text you want to locate in the current message.



Print prints the current message.



Save stores this message.    You must select a folder and enter a file name for the message text.



Edit Filters opens the Filter Editor so you can modify the filters list.



Attach File opens the Open file dialog so you can select the file you want to attach to your message.



Send sends the message.



Send Later saves the message to your Outbox when you’re not online so it can be sent later (when you’re connected).



Check Spelling checks the spelling of the text in the body of your message.



Print prints the current message.



Address List shows the entries in your address book.



Display Name – Enter the person’s name as you would like it to appear in the open address book on the Write Mail 
window.



Enter the Email Address for the person.



Message Body shows the text of the message.



Message Preview Header shows who the currently selected message is From, who it was addressed to and the subject 
of the message.    If there are any attachments with this message, you will also see the Save Attachments button.



Message Preview shows a preview of the text in the currently selected message.    To open the message in another 
window, double click the message summary in the message list.



Folders lists the folders in your EarthLink MailBox



Message List shows the message in the current folder.    Bold messages are unread messages.



Always check the default mail program when starting EarthLink 5.0



Enter the name for the new folder.



Add an item to this list.



Attachments saves or opens the attachment(s) in this mail message.



Click BCC to add the highlighted names in your address book to the current message BCC field.



Click CC to add the highlighted names in your address book to the current message CC field.



Delete removes the selected item.



Highlight the entry you want to edit, then click Edit.



Save Attachments saves or opens the attachment(s) in this mail message.



To - highlight one or more addresses in your address book then click this button to copy them to the To field.



Message must satisfy all of the conditions – Actions will only be applied to messages that match ALL of the selected 
conditions.



Message must satisfy any of the conditions – Actions will be applied to any message that meets at least one of the 
selected conditions.



If the From field contains an address which is – Check this option to compare the contents of the From field with the 
entries in your address book.



If the From field contains the following text – Check this option to compare the contents of the From field with the text 
you enter here.



If the From field does NOT contain the following text – Check this option to compare the contents of the From field with 
the text you enter here.



If the To or Cc fields contain the following text – Check this option to compare the contents of the To or Cc fields with 
the text you enter here.



If the To or Cc fields do NOT contain the following text – Check this option to compare the contents of the To or Cc 
fields with the text you enter here.



If the Subject field contains the following text – Check this option to compare the contents of the Subject    field with the
text you enter here.



If the message contains the following text – Check this option to compare the contents of the message with the text you
enter here.



From contains – enter the address or text that you want to check for.



From does not contain – enter the address or text that you want to check for.



To or Cc Fields contain – enter the text that you want to check for.



To or Cc Fields do NOT contain – enter the text that you want to check for.



Message text contains – enter the text that you want to check for.



Subject text contains – enter the text that you want to check for.



In my address book – if the address in the From field IS in my address book apply the selected conditions.



Not in my address book – if the address in the From field is NOT in my address book apply the selected conditions.



Nothing – do nothing to the filtered message.



Move the message to the folder – select this option to move the filtered message to an existing folder.



Move to this folder – select the folder you want to move the filtered message to.



Copy the message to the folder – select this option to copy the filtered message to an existing folder.



Copy to this folder – select the folder you want to copy the filtered message to.



Permanently delete the message – deletes the filtered message.    You won’t even see the message in your Trash folder.



Reply to the message with the file – select this option if you want to return an attachment to the sender.



Reply with this file – select the file name you want sent back to the sender.



Forward the message to the address(es) – select this option to forward the filtered mail to an address you specify.



Forward to these address(es) – enter the address(es) you want to forward these messages to.



Filters lists the filters that have been created.    A Check mark indicates an active filters.    Active filters are processed in 
the order listed.



View Small Toolbar displays small toolbar buttons thereby conserving space on your desktop.



View Large Toolbar displays large toolbar buttons making the images easier to see.



View Text Labels displays text beneath each toolbar button to describe its function.



Filter Rule Description shows the conditions and actions you selected for this filter rule.



Open Attachment opens the selected attachment if the helper application is available.



Rule Name – enter a name for this new filter rule.



Save this attachment – allows you to save the selected attachment to a folder of your choice (or to your Desktop).



Move opens the Move Folder dialog so you can highlight the folder you want to move the selected folder (and its 
contents) into.



Copy opens the Copy Folder dialog so you can highlight the folder you want to copy the selected folder (and its 
contents) into.



Lists the email addresses.    You can add, edit or delete names in this list.



The text of the selected mail message.



Shows the body of the message in the preview pane.



Click Suggest to display alternatives for the problem word.



Shows alternatives for the problem word that was found.



Click Undo to reverse your most recent selection.



Enter/select the name of the folder you want to move the selected item into.



Shows the body of the message in the preview pane.



Click Ignore All to bypass all occurrences of the problem word.



Click Ignore to bypass only this occurrence of the problem word.



Message Source shows the source text, including HTML coding (if any) and detailed header information.



Click Change to change the current misspelled word with your selection.



Click Change All to change every occurrence of the misspelled word with your selection.



Problem – shows the problem word – the label for this field will reflect what is wrong with the word:    Capitalization, 
Consider changing, Double word, Mixed case, Contains digits, or Not in dictionary.



Results – lists the results of your most recent Check mail operation.



Shows the Progress during the Compact Folder operation.



Find
TO DO: Enter topic text here!



Retrieve Large Messages Now
TO DO: Enter topic text here!



Browse – Click here to browse to the folder where you want to save your attachments.



Select All – Click here to select all the attachments at once. Then you can save them all to the same place at the same time.



 Blocked Senders List
The Blocked Senders list contains the list of senders you no longer wish to receive mail from.
Addresses get added to this list when you click Junk to send a message to the Junk Mail folder, or when a message gets filtered
by the Mail Scrubber.
You can add or remove senders from this list by selecting Edit Blocked Senders from the MailBox menu.



 Rename Folder
Use the Rename Folder dialog to specify a new name for the current mail folder. The folder name cannot exceed 30 characters.



 New Folder
Use the Create New Folder dialog to specify a name for a new mail folder.    The folder name cannot exceed 30 characters.



 Move Message
Use the Move Message dialog to specify the folder you want to move the selected message into.



 About EarthLink MailBox
Provides the version number for this release of EarthLink MailBox.



 Filter Editor
The Filter Editor enables to select the filters you want to apply to incoming mail.    EarthLink MailBox supplies two predefined 
filters: the Mail Scrubber  and the Aggressive Mail Scrubber.These filters are dependent on the entries in your Address Book. 
Therefore, you should NOT select either of these options if you have not added entries to your address book.        
Filters are processed in the order in which they are listed on this screen. Therefore. your most specific filters should be toward to 
the top of the list (like a filter that puts all Aunt Tilly’s messages in a Jokes folder) and the more general filters should be toward 
the bottom of the list (like the Mail Scrubber).    Filters that are NOT checked are ignored.

To select a filter, check the box to the left of the filter name.
To deselect a filter, uncheck the box.
To change the order of the filters, select the filter you want to move, then click either Move Up or Move Down.
Adding a Filter 
Editing a Filter 
Deleting a Filter 
Turning a Filter On or Off 
Reorganizing Filters 
Examples of Some Basic Filters 



 Filter Rule Wizard Conditions
The Filter Rule Wizard – Step 1: Select the Conditions is the first step in creating your email filter.    On this dialog you identify to 
information you want to search for.    For example, if you don’t want to see messages containing the word “SEX” in your Inbox 
you can do just that (check If the message contains the following text and enter SEX in the field).
There are three basic components to this dialog: the Address Book component, the Contains or Does not contain component, 
and the Any or All component.
· The Address Book checkbox enables you to filter mail based whether it comes from people you know (who are listed in your

address book) or people you don’t know (NOT in your address book).    
· The Contains or Does not contain checkboxes enable you to filter mail based on the contents of the From, To, CC, Subject 

fields or text in the body of the message. Check the desired box(es) and enter the text you want the filter to look for.
· The Any or All option buttons lets you decide if a message must meet ALL of your selected conditions or ANY one of the 

conditions in order for the specified action to be applied to the message (you decide the actions on the next dialog ).



 Filter Rule Wizard Actions
The Filter Rule Wizard – Step 2: Select the Actions is the second step in creating your email filter.    
On this dialog you decide what you want done with all those messages that meet the condition(s) you set on the previous dialog .
For example, if you never want to see messages that contain the word “SEX”, you can do that (check Permanently delete the 
message) and any messages containing the word “SEX” will be delivered directly to your Trash folder.
If your Aunt Tilly sends you jokes that clutter your Inbox, you can have all messages from Aunt Tilly moved to a Jokes folder.
If you want any mail not addressed specifically to you moved to the Junk Mail folder, you can do that.
If you’re taking a sabbatical and someone else will me handling your mail while you’re gone, you can forward mail to another 
address. 
If you’re only headed off to Maui for two weeks, you can have a reply message sent to certain senders so they know not to 
expect an immediate response.



 Filter Rule Wizard Verify and Name 
The Filter Rule Wizard – Step 3: Verify and Name the Rule is the third step in creating your email filter.    
On this dialog you review the conditions you selected in Step 1 and the actions you specified in Step 2, then you give your filter a
name.    Once you click Finish, the name of this new filter will be added to the list of filters on the Filter Editor window.    
Be sure to place a check in the box to the left of this filter name to make it an active filter.    
IMPORTANT:    Filters are processed in the order listed on the Filter Editor window.    Your most specific filters should be toward 
to the top of the list (like a filter that puts all Aunt Tilly’s messages in a Jokes folder) and the more general filters should be 
toward the bottom of the list (like the Standard Spam Senty Junk Mail Filter).    Filters that are NOT checked are ignored.



 Address Book Editor
Use the Address Book Editor to organize and maintain your address book entries.    You can use these entries when creating a 
new mail message so you don’t have to type email addresses, you can just drag an entry from the address book to the 
message.    Your Address Book is also a vital component of the EarthLink 5.0 filter system.    EarthLink offers two filters that help 
you control the amount of unsolicited mail that appears in your Inbox.    The two predefined filters: the Mail Scrubber  and the 
Aggressive Mail Scrubber both rely on the entries in your address book. In a nutshell, if mail arrives from someone not listed in 
your address book and you have one of these filters turned on, the mail will not appear in your Inbox.
Adding an Address Book Entry 
Editing an Address Book Entry 
Deleting an Address Book Entry 
Using Filters 



 Edit Address Book Entry
Use the Edit Address Book Entry dialog to modify the information for an existing email address.    
The Display Name is the name you see when you open the address book in a Write Mail window.
The Email address is the address the mail will be sent to.



 List Editor
This dialog enables you to maintain the entries in this list.
Click Add to add a new name and email address.
Select a name and address then click Edit to modify the entry.
Select a name and address then click Delete to remove the entry from the list.



 Properties
The name and email address for the selected entry.



 Move Message
This dialog lists the mail folders that you can move your message into.    Select the desired folder then click OK.



 Check Spelling
This dialog lists words found in your message that there is some problem with.    The label to the left of the first field identifies the 
type of problem encountered.

¨ Capitalization shows a word that is not capitalized but should be, such as england. 
¨ Consider changing shows a word you may have changed in the past so it is marked in the dictionary as “Conditionally 

Change”. 
¨ Double word shows two identical words in a row, such as that that. 
¨ Mixed case shows a word with an unusual combination of upper- and lower-case letters.
¨ Contains digits shows a word that contains numbers, such as Windows95. 
¨ Not in dictionary shows a word in your mail message that is not in the dictionary, such as sdfqz.    If you want to add this 

word to the dictionary, click Add to Dictionary. 
¨ Change to shows the recommended word. You can type a correction in this field.
¨ Suggestions lists other alternatives – highlight a word in this list to move it to the Change to field.
When you’re ready to take action, click one of the following buttons:
¨ Click Change if you want to replace the problem word with the word in the Change to field. 
¨ Click Change All to replace all occurrences of the misspelled word. 
¨ Click Ignore to ignore this word or click Ignore All to ignore all occurrences of this word. 
¨ Undo reverses the change you just made.    
¨ Suggest populates the suggestion list – use this when you type in a word in order to check its spelling.



 Blocked Senders Editor
The Blocked Senders Editor enables you to maintain the list of senders you’ve blocked by clicking on the Junk Mail button.    Any
mail from a sender in this list will be “blocked” and sent to the Junk Mail folder instead of your Inbox.
To manually add a sender to this list:
 Click Add then enter the name and email address of the sender.

To edit a sender’s entry:
 Select the sender’s name then click Edit and make the desired changes.
To delete a sender from this list:
 Select the sender’s name then click Delete. A confirmation window will appear.
 Click Yes to confirm the deletion.



 Address Book Editor
Use the Address Book Editor to organize and maintain your address book entries.    You can use these entries when creating a 
new mail message so you don’t have to type email addresses, you can just drag an entry from the address book to the 
message.    If you’re using filters to keep the clutter out of your Inbox, maintaining this list is important.    Mail from people in this 
list will never be deleted or sent to the Junk Mail folder.    Your Address Book is also a vital component of the EarthLink 5.0    junk 
mail filter system.    EarthLink offers two filters that help you control the amount of unsolicited mail that appears in your Inbox.    
The two predefined filters: the Mail Scrubber and the Aggressive Mail Scrubber both rely on the entries in your address book. In 
a nutshell, if mail arrives from someone not listed in your address book and you have one of these filters turned on, the mail will 
not appear in your Inbox.
You can have names of people you send mail to automatically added to the Address Book by checking the Automatically put 
people I send mail to into my Address Book option on the Mail Send preferences page in your profile settings.    You can have
the name of people who send you mail automatically added to the Address Book by checking the Automatically put people I 
receive mail from into my Address Book option on the Mail Read preferences page.
To manually add a name to this list:
 Click Add then enter the name and email address.

To edit an entry:
 Select the name then click Edit and make the desired changes.

To delete an entry:
 Select the name then click Delete.

Using Filters 



 Edit
Use this dialog to change the name and/or email address for the selected entry.



 Check Default Mail
You have your choice of email programs.    Currently, EarthLink Mailbox is not your default mail program.



 Find
The Find dialog enables you to search for text within a message:
Enter the text then click Find.    Find will locate the first message in which the word or phrase appears.    If that isn’t the message 
you were looking for, click Find again.



 Open Attachment
Click Open a temporary copy if you want to open a temporary copy of this attachment.
Click Save this attachment if you want to save the attachment to a folder of your choice (or your Desktop).
Then click OK.



 Select Folder
This dialog lists the email folders defined on your system.    Select the desired folder.



 Suggestions
Lists the suggestions for the problem word.    Select the desired replacement.



 Multiple Matches
There is more than one address in your Address Book for the name you typed. Which address would you like to use?



 Message Source
Shows the source of the message, including the complete mail header.    If the message was encoded using HTML, you will see 
the codes embedded in the message.



 Results
This dialog shows the results of your last Check mail action.    If you have Don’t download messages larger than 500Kb 
checked in your Mail Read preferences and a large message was encountered and skipped, you can click Receive large 
downloads now to download the large message.    Large messages will stay on the mail server until you retrieve them.
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You are low on system resources
Your system may not behave as expected while in this condition.    To remedy the low on resources condition, close any 
extraneous EarthLink 5.0 windows or other programs that are currently running on your computer that you are not currently 
using.    To close EarthLink 5.0 windows you are no longer using, click on the Window menu and select the name of the window 
you want to close, then either double-click on the icon to the left of the File menu, or select Close from the File menu.    Repeat 
this process until you have closed all extraneous windows.
Note: If you have a number of icons in your System Tray, these also impact system resources.    If you consistently get “low on 
resources” messages, you should consider closing a number of these programs. To close a program in your System Tray, right 
click on the icon and click Close or Exit.



You are no longer connected to the Internet
You will not be able to send or receive email, upload or download files, or view web sites online unless you are connected to the 
Internet. Click Yes to connect to the Internet now.    Click No to continue working offline.



EarthLink Technical Support
EarthLink maintains a website containing solutions to many technical issues at http://help.earthlink.net
EarthLink Technical Support is available 24 hours a day, 7 days per week at (800) 890-5128.
MindSpring customers can get Technical Support for their accounts 24/7 at (800) 719-4660.



 Formatting an Email Message
EarthLink MailBox now provides full rich text support for all incoming and outgoing email. You can control the look of your mail 
message, just as you would any other document, by applying fonts, color and other formatting characteristics. When you apply 
formatting to an email message, EarthLink MailBox sends that message as HTML email.
To apply formatting to a message:
 Select the text you want to apply formatting to.
 Select any combination of the following:

The following items are listed in the order in which they appear on the Formatting (Styles) toolbar. 
· Choose a font from the drop-down list to apply to the selected text. 
· Choose the size of the font of the selected text.
· Choose a style for the selected text.
· Click Bold to apply the bold attribute to the selected text.
· Click Italic to apply the italic attribute to the selected text.
· Click Underline to apply the underline attribute to the selected text.
· Click Text Color to list and choose a color for the selected text.
· Click Background Color to list and choose a background color for your email message.
· Click Ordered List to turn the selected text into a numbered list.
· Click Bulleted List to turn the selected text into a bulleted list.
· Click Left Indent to remove indentation from the selected text.
· Click Right Indent to indent the selected text.
· Click Left Align to align the selected text along the left margin.
· Click Center to center the selected text between the left and right margins.
· Click Right Align to align the selected text along the right margin.
· Click Picture to choose a picture to insert into your text at your cursor’s current position.

These options are also available from the Format menu.



Applies Bold to the selected text, or turns on Bold for subsequently typed text.



Applies Italic to the selected text, or turns on Italic for subsequently typed text.



Applies Underline to the selected text, or turns on Underline for subsequently typed text.



Text Color enables you to change the appearance of the text in your message to another color in the color palette.



Background Color enables you to change the background color of your email message.



Numbered List applies numbered list formatting to the selected text.



Bulleted list applies bulleted list formatting to the selected text.



Decrease Indent undoes or decreases the previously indented text (and moves the text to the left).



Indent Indents the selected text (moves the text to the right).



Left Alignment aligns the selected text with the left margin – right edge ragged.



Center Alignment aligns the selected text with the midpoint between the left and right margins –left and right edges 
ragged.



Right Alignment aligns the selected text with the right edge – left edge ragged.



Font Name enables you to choose a different font for the selected text.



Font Size enables you to change the size of the font for the selected text.




